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So rings exist for diverse topics—physical fitness,  
photography, falconry, biking, etc. In fact, those topics 
were all featured on WebRing.com  
http://dir.webring.com/rw, a directory of rings, on the 
day I browsed it. 

The WebRing concept is simple: Webmasters of sites 
with a common theme agree to link to each other, and 
to a hub Web site; each ring site includes links named 
Ring Hub, Random, Previous, Next, and Join Now. A 
ring’s hub is like the center of a circle, with all the 
ring’s sites connected to it. The hub describes the ring, 
gives statistics (how many Web sites belong, how 
many times the hub has been visited, etc.), and lists 
member sites with brief descriptions.  

(Continued on page 14) 

If the Internet is the largest library created in human 
history, where are its card catalog and friendly li-
brarians to explain how the Internet’s “shelves” are 
arranged? Where’s a rhyme and reason for how 
things are arranged, and the Dewey Decimal System 
http://www.oclc.org/dewey/ when we need it most? 
Search engines and directories like Google 
www.google.com and Yahoo! www.yahoo.com are 
helpful but can be overwhelming. And search results 
often appear jumbled, lacking the comfort of 
neighborhood libraries which shelve related books 
together—so that if you find an interesting mystery, 
cookbook, or science tome, its nearby shelf 
neighbors may be an unanticipated bonus. 

But the Internet does offer the equivalent of library 
shelves, called WebRings (“rings” for short). Not 
stashed where you can physically touch them, rings 
are linked sets of Web sites concerned with specific 
topics. 

Browsing WebRings:  
Communities Of Web Sites 
By Gabe Goldberg, APCUG Advisor, Region 2 

November 2006 Volume 29 Issue 7 

www.nctcug.org 
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In working to help Club members and others with 
their computer problems during the Thursday morn-
ing Computer Talk sessions, or more often when 
making “house calls,” I often hear strange tales that 
usually involve acts of some gremlin like creature. 
However, gremlins are more closely related to me-
chanical problems in aircraft.  

Generally the caller’s comments start with “all of a 
sudden” or “suddenly” and end with “I didn’t’ do 
anything.” I can only surmise that it was probably 
one of cartoonist Bill Keane’s ghostly imps “Not 
Me.” “Nobody” or even “Ida Know.”  

Some recent examples 

“Suddenly…” 

One morning a couple of weeks ago, I received a 
call and the person on the other end of the phone 
connection was obviously very upset. She ex-
claimed: “Suddenly all of my desktop icons are 
gone! I didn’t do anything! Please help me!”  

This situation seemed to be serious. I had never 
heard of this happening. I didn’t have anything on 
the calendar for another two hours so I hopped in my 
1999 “Sapphire Blue Mica” (marketing division 
color name of course) Miata for the 
short drive up the hill to her Tall Mesa 
Village home. She was right, the icons 
were indeed missing. A simple right 
click on the blank desktop, hover over 
Arrange Icons by: and then click on 
Show Desktop Icons. This was defi-
nitely an act by the “little people.” As 
I said, I hadn’t heard of this situation 
before. Therefore, it must have been 
“Not Me” wishing to get off the hook 
by whispering in my ear how I might 
arrive at the solution. Since the club 
member was in the back room and the 
house girl had let me in, I quickly left 
the scene.  

The next day the same lady called and said that her 
“My Computer” Icon was missing from the desk-
top. Realizing that it wasn’t the normal desktop 
shortcut icon, I was puzzled. Not thinking things 
through, I again slid onto the seat in the Miata and 
shortly arrived on the scene. Sure enough most 
icons were visible, but the “My Computer” icon 
was not in its normal position. It wasn’t immedi-
ately visible. I later noticed the top edge of the 
icon protruding just above the task bar. Once 
again, I moved the pointer to a blank spot on the 
desktop, a right click on the mouse and chose Ar-
range Icons by and chose Name. The My Desktop 
icon again assumed its prominence at the upper 
left. She said that she didn’t drag and drop it down 
there. As I picked up a $20 donation to the Club, I 
assumed that it must have been “Nobody” and left 
for home.  

“Suddenly…” 

Monday morning is usually the time for the phone 
calls to begin. On a recent Monday, the caller 
sheepishly states that “suddenly I can’t access the 
Internet.” I recognized that the person speaking to 
me is the same one whose 18 year old grand-
daughter had placed hundreds of malware pro-
grams on his laptop two weeks before. At that time 

I had suggested a router/firewall so 
that she could plug her laptop di-
rectly to the router with Internet 
access. He had immediately gone 
out and purchased and installed 
one. Oh yes, the granddaughter 
had been there over the weekend 
and had brought her own laptop 
computer.  

The blue Miata once again headed 
up the hill (from our home in the 
Valley View Village all destina-
tions seem to be “up the hill.”) to 
their home in Arroyo Vista Vil-
lage. In just a few minutes, I found 

“Suddenly…” Or “I Didn’t Do Anything!” Part 1 
Or — A Month’s Log Of A Sun City Anthem Computer Club “House Call” Doctor 
By Charles W, Davis, Newsletter Editor & Webmaster, Sun City Anthem Computer Club,  
Henderson, NV  Chas(at)anthemwebs.com  www.myscacc.org 
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that the dear child didn’t plug the cable into the 
router as instructed, but had used grandpa’s com-
puter. Since she was an AOL user, she attempted to 
change Gramps’ Accounts from Cox Cable to AOL 
dialup and failed. It would have been so easy for her 
to have just gone to AOL using Internet Explorer. 
She left for school Sunday evening and didn’t men-
tion a thing to Gramps. That way, she didn’t have to 
tell on either “Ida Know” or “Not Me.” I picked up 
the $20 donation to the club and was soon on my 
way. 

An admonition: Set up a Guest Account without Ad-
ministrative rights. Place a User name and password 
on the Administrative (your’s) account. 

“All of a Sudden…” 

“All of a sudden” turns up many times a month and 
in some unusual situations. Last week, I received a 
call from a member that was using Microsoft Office 
Outlook. It seems that she had been entering infor-
mation into a new contact when “all of a sudden” she 
couldn’t enter information. She explained that she 
had been using Outlook and contacts for years and 
had never had this problem. Since this didn’t seem 
(to me) that this required immediate attention, I ar-
ranged an appointment for the next morning. My 
Miata and I arrived at her Golf Mesa Village home 
just as the Grandfather clock guarding the entry was 
announcing that it was 10:00. Grandfather clocks that 
I am aware of don’t announce “a.m.” or “p.m.” 

She met me at the door and we proceeded to the of-
fice and she took her place in front of her computer 
to show me what was happening. She began keying 
in the   house number, using the numeric key pad and 
just as she had said, nothing worked as expected. I 
immediately saw why this had happened so 
“suddenly.” Apparently “Nobody” had pressed the 
Num Lock key thereby turning it off. So as she 
would enter a house number, things went wild as the 
2,4, 6, and 8 keys acted as direction keys, 7 & 9 were 
Home and Page Up respectively and 1 & 3 were End 
and Page down. I asked her to press the Num Lock 
key and “all of a sudden” the problem was resolved. 
I collected the $20 donation check to the club and 
was homeward bound — downhill of course.  

“Suddenly…” 

On another Monday, I received a call from a 
member stating that she had recently upgraded to 
MS Office 2003 and a short time later, suddenly 
she could no longer access MS Publisher files. 
This was the result of someone else messing with 
functions that they should have stayed away 
from. Support teams at Norton will vow “Not 
me.” But when the lady was directed to an article 
titled “How to use Office programs with the Nor-
ton Anti-Virus Office plug-in” she was able to 
resolve the problem as I watched. This article can 
help you extricate yourself and may be found at: 
http://support.microsoft.com/kb/329820/en-us 

It is maddening to think that one, nay thousands 
upon thousands, must jump through hoops be-
cause a bunch of programmers at Symantec 
(Norton) can’t get it right.  

I have never understood their automatic plug-in 
installation. At least they should tell the user, in-
cluding a list of possible problems and their reso-
lution, and let them make a decision as to 
whether to install the plug in. Who needs viruses 
when “reputable” software manufacturers can do 
things like this to you? 

A long time ago, in computer time, but actually 
just over a year ago, I stopped paying the extor-
tion money for antivirus software and have used 
the free AVG antivirus, which is available from 
http://free.grisoft.com/doc/1  

“Suddenly...” 

“Suddenly” you can’t open Word or most other 
Microsoft Office products. This happened be-
cause you owned a Hewlett Packard multi-
function printer with a flash memory card reader. 
It seems that a security update messed with the 
logic for these systems and caused much havoc 
around the world. A follow-on update was re-
leased to affected computers during the 4th week 
in April. If you are still having the problem, go to 
Start then Windows Update, download and install 
all Critical updates. It seems that “Ida Know” 
visited Microsoft’s Redmond campus… 

(Continued on page 4) 
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Suddenly…” 

Last week, one of your neighbors in the Valley 
View Village went to his neighbors stating that his 
phone went “dead.” On investigation, it was 
learned that he had ordered and installed a new 
Voice over Internet Protocol (VoIP) phone system. 
Some of the equipment had arrived, but due to a 
transposition of digits when entering the credit 
card number, the important “Silver” box did not 
get shipped. “Ida Know” didn’t know how the mix 
up occurred. “Who Knows” stated that the cus-
tomer probably discarded the silver box with the 
packaging. However, the land line telephone pro-
vider had been notified to discontinue the service. 
“Dead line!”  

An admonition: Always check the contents of 
packages to make certain that all components are 
included before installing anything! 

The Federal Communications Commission has a 
web site that explains most aspects of VoIP:  
http://www.fcc.gov/voip/ 

Not so “Suddenly…” 

This particular call arrived on a Tuesday, so I was 
surprised to hear: “Suddenly I can send e-mail but 
I can’t receive any messages. Everything times 
out. I’ve called Cox Communications and since I 
use Office Outlook 2003, they weren’t much 
help.” This phone call came in at a time that 
Vickie was out and wouldn’t return for a while, so 
I slid behind the wheel of the Miata and headed for 
Ridgecrest Village to see what had happened so 
“suddenly.”  

It took several minutes of attempting to send mes-
sages to the owner’s e-mail address. Sure enough 
the message would be sent, but no incoming mes-
sages. After some time it would all time out. The 
first inbound message would never arrive. I found 
that there was no Internet access using Internet 
Explorer. I installed Firefox from my USB Flash 
memory and was then able to access the internet. 
At this time clues began to appear one-by-one.  

(Continued from page 3) Norton Internet Security was warning of Firefox 
accessing the Internet — twice!  

ZoneAlarm was warning of Firefox accessing the 
Internet! 

Oops! Only one program firewall at a time is al-
lowed. Since the member’s Norton subscription was 
about to expire, I downloaded AVG antivirus to his 
desktop (free at http://free.grisoft.com), shut off the 
cable modem, went to uninstall Norton System-
Works and discovered two versions. I uninstalled 
both. When I attempted to install AVG antivirus, 
the program indicated that the version of the Roxio 
CD creator contained code that was incompatible 
with AVG, and it provided a link for an update. I 
installed the update and then successfully installed 
the AVG antivirus. Then I turned on the cable mo-
dem and downloaded updates. I was grateful to the 
AVG programmers to make that test and inform the 
user. Suddenly, I decided that I like the AVG anti-
virus program and its creators even more than in the 
past. 

Now I felt that I could address the original problem. 
I opened Office Outlook, and it proceeded to 
download a monstrous movie clip — 9.87MB! It 
was able to complete the download due to the fact 
that Norton wasn’t scanning inbound e-mail mes-
sages.  

“Suddenly” wasn’t really all that sudden. The sec-
ond and third firewall programs were installed over 
a period of time, but the problem didn’t manifest 
itself until the arrival of the large file. As an aside, 
it was a clip from a newscast relating the story of an 
autistic youth that had been the go-fer for a high 
school basketball team. On the last game of his sen-
ior year, the coach (dad) suited him up put him in to 
play. I believe that I saw through the tears that 
welled up in my eyes over 21 points racked up — 
all three pointers. I’m not a sports fan, but am a fan 
of the underdog! $20 more for the Club’s treasury. 

This article was originally published in Bits, PCs & Macs. Bits 
PCs & Macs is the newsletter of the Sun City Anthem Computer 
Club. All copies are available online at: http://www.myscacc.org/
newsletters.htm   
There is no restriction against any non-profit group using this 
article as long as it is kept in context with proper credit given the 
author.  The Editorial Committee of the Association of Personal 
Computer User Groups (APCUG), an international organization 
of which this group is a member, brings this article to you. 



November 2006    The NCTCUG Journal Page 5 

www.nctcug.org 

Sometimes you just don’t know what’s in a file by 
the title alone. You may have created it so long ago, 
you’ve forgotten. Or, you received a file from some-
one who gave it a cryptic name. Most of the time, if 
you are like me, you bite the bullet and open the 
darned thing. This means waiting for an application 
to load before the file opens. If your attention does-
n’t wander, you’ll spend exasperating seconds — 
maybe even a minute or more — drumming impa-
tiently on the desk. Otherwise, you get distracted 
looking through papers or books in your To Read 
stack, and jerk to awareness 10 minutes after the file 
has opened. 

Either way, you don’t get the information you need 
when you want it. 

Call it secret, or just overlooked information, but 
there are ways to glimpse file information so you 
don’t have to open the files or folders to see what 
they contain. 

FILES — Stay with me while I open my OR-
COPUG folder in the Details view and click on a 
subfolder titled Ira Wilsker. There’s a list of files in 

the right window pane that I have saved Ira Wilsker’s 
emails. But, now I’m not sure what they contain. So, I 
go to View on the menu bar and check to be sure that 
Status Bar has a check next to it. Next, I click on the 
file titled “ATT00010.doc.” [figure 1] 

The author of the file, the actual title of the file, the 
date it was created and the size of the file all appear at 
the bottom of the pane in the status bar. [figure 2] 

Or, I could just hover the mouse over the file name 
for a second or two and a popup will show me the file 
information. [figure 3] If you don’t see a popup when 
you hover your mouse over a file, in an open folder 
go to Tools > Folder Options > View. Then, scroll 
almost to the bottom of the list and check the box 
next to “Show pop-up description for folder and 
desktop items.” 

The third option for checking on file innards is to right 
click on the file name, and go to Properties in the drop 
down list. Left click on Properties and go to the Sum-
mary tab. The author’s name and the title of the docu-
ment will be there. [figure 4, next page] 

(Continued on page 7) 

How To Know What’s In A File Or Folder Before You Open It 
By Linda Gonse, Editor, Nibbles & Bytes, Orange County IBM PC Users’ Group, California 

Figure 2: Information about a file shows up in the Status Bar at the bottom of an open folder. 

Figure 3: Hover your cursor over a file for a popup 
box with the file information in it. 

Figure 1: To add the Status 
Bar to your folders, you 
have to select it under View. 
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Figure 5 Figure 4: The Properties box defaults to 
author and title. Other information can 
be added to this file, also,  at the time 
the document is created or modified. 

Figure 6 
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FOLDERS—You can make searching through fold-
ers easier (and even more fun) by using a custom pic-
ture to remind you of the contents. Or, you could as-
sign a custom icon for the folder so it will stand out 
from the rest of the folders. 

Go to the settings under the View menu in an open 
folder. First select Thumbnails. Then, go back into 
the list and click on Customize this Folder. [figure 5] 

Click on the Customize tab and then the “Choose 
Picture” button. [figure 6] Find a picture in the folder 
(or in any other folder) that will remind you of what 
types of files are in this folder. For example, my fold-
ers are filled with articles for the newsletter from 
various writers. One folder contains articles by Ira 
Wilsker and images for his articles, so it makes sense 
to put Ira’s photo on the folder. I browse to his pic-
ture, select it, click Open, then click Apply and OK. 

Take a look at the folder now (below) in Thumbnail 
view. There’s no way you can miss this folder, or 
forget what is inside of it! [figure 7] 

(Continued from page 5) 

In other views, such as Icon view, you won’t be 
able to see a picture on the folder. But, you can still 
make the folder stand out from the rest. Or, if you 
have a group of folders that are similar, you can 
change all the folder icons so they will stand out as 
a group and be easier to locate. [figure 8] 

To change a folder’s icon, go back to View and 
Customize This Folder. At the botton of the dialog 
box, click on the Change Icon button, and select an 
icon. Click Apply and OK, and go take a look at the 
folders in icon view. [figure 9] 

It’s hard to miss the special icon, isn’t it? 

Try it yourself and discover how easy it can be to 
identify the folders you need, instantly and without 
guesswork. 

There is no restriction against any non-profit group using this 
article as long as it is kept in context with proper credit given the 
author.  The Editorial Committee of the Association of Personal 
Computer User Groups (APCUG), an international organization 
of which this group is a member, brings this article to you. 

Figure 8 Figure 7 

Figure 9 
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The main straight-ahead wall is the home view, a 
browser window controlled by a tool bar. It can be 
zoomed to occupy the full screen, momentarily hid-
ing the side walls. The left wall shows your browsing 
history, pages you’ve visited. It’s much easier navi-
gating to these pages visually vs. the usual cryptic 
browser back button: simply right click a page to 
bring it back to the home view. 

The right wall is a multi-talented workhorse. It can be 
automatically filled with pages linked from the cur-
rent home view, avoiding interrupting current atten-
tion while allowing instant jumps to linked pages. A 
handy use for this is pre-loading top entries in search 
engine results lists. The right wall can also be used 
like a corkboard, loaded with pages to be kept handy 
for quick reference; this is called making it “sticky”. 
And it can be put in “4-live” mode which displays 
four active browser windows with clickable pages. 
This allows quick site viewing and comparing, or 
monitoring multiple auto-updating pages simultane-
ously, such as saving/tracking multiple auction items 
though the sale process. Right-wall pages can be rear-
ranged, scrolled, flipped between Auto Crawl and 
sticky. And right-wall and sticky contents are sepa-
rately cleared. 

Pop-up window behavior—normally an annoyance—
is customizable: ignore, open in new window, open 
on right wall, open in current browser, or ask for in-
structions. 

An elegant “rooms” feature extends browser book-
marks/favorites, allowing saving and sharing collec-
tions of Web pages as single files. Any selected 
pages can be grouped; you might gather family, rec-
ipe, financial, or technical pages. Rooms can hold 
static pages (content when pages were collected) or 
dynamic pages (links to pages as they are when the 
room is viewed). Opening a room displays pages as 

they were positioned when the room was 
saved. 

(Continued on page 10) 

It’s hard to imagine a different world. A great early 
science fiction book Flatland [www.eldritchpress.org/
eaa/FL.HTM] describes life in a two-dimensional 
world, with creatures unable to imagine the third  
dimension we take for granted. And modern physics’ 
“string theory” [www.pbs.org/wgbh/nova/elegant/] 
speculates that our world really has eleven dimen-
sions. 

While I can’t imagine those extra dimensions, we 
spend time in a two-dimensional world every day—
it’s how most people browse the Web. But even that 
has changed, as browsers have evolved from display-
ing one site per window to more flexible tabbed 
browsing, displaying many Web pages in a single 
window. 

So now it’s interesting and fun to take three-
dimensional browsing out for a cruise, surfing the 
Internet, courtesy of Browse3D. This visual-
browsing style lets you see forward and backward, 
where you’ve been and where you’re going. It’s 
great for browsing that involves a lot of forward-and-
backward navigation, or that requires following 
many Web links. 

When first started, Browse3D offers abundant help-
ful tips for use. These can be scrolled all at once or 
browsed each time the program runs. And built-in 
Help provides a comprehensive tutorial highlighting 
features and capabilities. 

This tool wraps around Internet Explorer — the  
vendor calls it a “reverse plug-in”—to display Web 
pages on multiple walls, shown three dimensionally 

on our two-
dimensional 

monitors. 

Add A New Dimension To Your Browsing 
By Gabe Goldberg, APCUG Advisor 
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The IE window toolbars can take up a lot of space 
that could be better used to see web page content.  
This can be especially critical with small monitors 
and/or with low resolution settings.  But even with 
my 21" monitor at 1280 by 1024 pixels I like to 
maximize the viewing area.  The graphic shows my 
setup (split into two rows to show the detail). 

Below the Title bar are the Menu, Standard Buttons, 
and Address Bars in one row.  Below these is the 
Links Bar that has the full width of the window for 
its choices.  Note that for the Standard Buttons Bar 
I have reduced the choices to just Back, Forward, 
Stop, and Refresh.  These are the only tools I use 
frequently.  The functions of some other tools can 
be found under View, Explorer Bar.  Make the se-
lection via menu item View, Toolbars, Customize.  
Also in the Customize Toolbar window are the op-
tions to select “Small icons” and to have “No text 
labels” — my choices. 

Some users may not realize that toolbars can be 
moved to the row occupied by the Menu Bar, but IE 
version 6 allows this.  To make the move go to 
View, Toolbars, and uncheck “Lock the Toolbars.”  
This enables vertical bars at the left end of toolbars.  
These are “Handles” that can be dragged with the 
mouse cursor.  Once a satisfactory arrangement is 
found, go back and check “Lock the Toolbars.”  
This insures against accidental rearrangement of the 
toolbars. 

The Links toolbar, a special function of the Favorites 
menu because Windows and IE make its content avail-
able on the toolbar, contains internet shortcuts that I 
access frequently.  Actually, in my system it has more 
choices than I really need because I have the space for 
them.  And I shorten the references to the web sites 
they point to to make space for as many as possible.  
For instance YahMail points to the web page for Yahoo 
Mail, http://mail.yahoo.com/.  And NAVUp points to 
the web site for updating Norton Antivirus references, 
http://www.sarc.com/avcenter/download/pages/ 
US-N95.html.  The same shortcuts can be found under 
menu item Favorites, Links. 

Another space saver is shortening the IE program name 
in the Title bar.  Typically it is "Microsoft Internet Ex-
plorer."  Other info in this bar is the web site or other 
info.  I changed the program name to IE6 to make more 
space.  This involved editing the Registry at 
HKEY_CURRENT_USER\Software\Microsoft\ 
Internet Explorer\Main to have an entry in the Name 
column of “Window Title” with a Value data of your 
choice (like IE6). 

One last note is that I set the default Home page to 
Blank to prevent IE from trying to go to a web site 
when the window is opened. 

Remember to tap the F11 key for more space. 
There is no restriction against any non-profit group using this article 
as long as it is kept in context with proper credit given the author.  
The Editorial Committee of the Association of Personal Computer 
User Groups (APCUG), an international organization of which this 
group is a member, brings this article to you. 

Getting The Most Viewing Space In The  
Internet Explorer Window 
by Glenn Richards, Emeritus Member of the Lake-Sumter Computer Society, Leesburg, FL 
www.lscs.us   grich32(at)yahoo.com 
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Browse3D is easily purchased online and 
downloaded/installed/registered; a free version lack-
ing a few features is also available. The software re-
quires a relatively powerful PC; it checks operation 
when installing. But most relatively current PCs 
should be adequate. Because of how it uses screen 
space, Browse3D is most impressive on larger moni-
tors.  

Company: Browse3D Corporation 
Product: Browse3D 
Price: Free or $29.95 
URL: www.browse3d.com 
Telephone: (888) 444-3200 

This article originated on AARP’s Computers and Technology Web 
site,  www.aarp.org/computers, and is copyrighted by AARP. All 
rights are reserved; it may be reproduced, downloaded, dissemi-
nated, or transferred, for single use, or by nonprofit organizations 
for educational purposes, with attribution to AARP. It should be 
unchanged and this paragraph included. Please e-mail Gabe Gold-
berg at gabe@gabegold.com when you use it, or for permission to 
excerpt or condense. 
There is no restriction against any non-profit group using this arti-
cle as long as it is kept in context with proper credit given the au-
thor.  The Editorial Committee of the Association of Personal Com-
puter User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 

(Continued from page 8) 

your hard drives for the strings “*.tmp” and 
“*.dmp” in filenames. Delete anything more than 
a week or so old; however, Windows will refuse 
to delete any files it considers important.  

Go through your saved e-mail and delete old mes-
sages. This will reduce the size of the mail data-
base file and help you to find important e-mail 
more quickly. 

Look at the list of installed programs (Start → 
Control Panel → Add or Remove Programs) and 
remove any you don’t use. Most of us find that 
new software often is less useful than we ex-
pected. Also, many PC manufacturers ship ma-
chines with software that we neither ask for nor 
need. While you’re checking, be sure to click on 
the Add/Remove Windows Components icon in 
the left margin of the window. You find MS tools 
that you don’t need. 

Windows allocates a large portion of your disk 
space for use by System Restore (Start → All Pro-
grams → Accessories → System Tools → System 
Restore → System Restore Settings). Select each 
drive and click on the Settings button. Reduce the 
Disk Space Usage by moving the slider to no 
greater than 1 GByte on each of your drives. Use 
less on small drives, especially if they contain 
nothing but data. 

Check the startup folder for programs that auto-
matically start; you will probably find that you 
don’t want many of these running. Start → All 
Programs → Startup to view the contents of the 
startup folder. To stop a program from starting 
automatically right click on its icon then click de-
lete. This does not delete the program; it only 
stops it from being started at boot-up. 

Unfortunately, most programs that start automati-
cally don’t appear in the startup folder. To disable 
these, click Start → Run and type “msconfig”. 
Click the startup tab and uncheck any programs 

Unless you are careful, after a period of use Windows 
will begin to slow down. This occurs because many 
programs are always active, even though you aren’t 
using them and because the number of files increases, 
which means that searches take longer. Fortunately, 
Windows XP contains several tools to help you ease 
these conditions. Using these tools periodically 
(every month or two is reasonable) will help you 
keep your PC lean and mean. 

Use Disk Cleanup to delete useless files. Right-click 
on a disk icon in Windows Explorer (C: will be the 
most rewarding); then click Properties, click the Disk 
Cleanup button, and select the actions. (I prefer not to 
compress old files as I’ve had bad experiences with 
compression.) Also be sure to check the actions avail-
able under the More Options tab, in particular delet-
ing all but the last restore image. Finally search all 

Windows XP Housecleaning 
By Dick Maybach, Member of the Brookdale Computer User Group, New Jersey  
http://www.bcug.com/    N2nd(at)att.net 
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of all the modules that start at boot-up. It shows in-
formation in each entry that may enable you to track 
down a troublesome program. As is common with 
Windows utilities, you can sort any column by click-
ing on its header. 

If you have problems with a program that ran with an 
earlier version of Windows, try running them in pro-
gram compatibility mode. Click Start → All Pro-
grams → Accessories → Program Compatibility 
Wizard → Next → Next. You will see a list of all the 
installed programs. Select the troublesome program 
and a compatibility mode (Win 95, Win NT, Win 98/
Me, or Win 2000). Clicking Next brings up a screen 
allowing you to set a lower resolution on the screen, 
which may be needed for very old Windows pro-
grams.  

You can tune your PC performance with very little 
risk, even if you are a novice. Right click on My 
Computer in Windows Explorer; then, click Proper-
ties → Advanced → Performance Settings. Usually, 
checking “Let Windows choose what’s best for my 
computer” is satisfactory, but you might to try 
“Adjust for best performance” if you machine is 
slow. If you are more adventuresome, you can select 
Custom and disable individual features by uncheck-
ing items in the list. If you don’t like the result, you 
can just go back to “Let Windows choose what’s best 
for my computer. 

After completing the cleanup check to see if you 
should defragment your disks. Right click on a disk 
icon in Windows Explorer; then click Properties → 
Tools tab → Defragment now → Analyze button. If 
Windows says the disk does not need defragmenting, 
don’t do it. Defragging the C: disk takes a long time, 
and seldom results in any noticeable performance 
improvement. 

There is no restriction against any non-profit group using this arti-
cle as long as it is kept in context with proper credit given the au-
thor.  The Editorial Committee of the Association of Personal Com-
puter User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 
 

you don’t want to run at startup. When you finish, 
Windows will ask you to restart. After boot-up you 
will see a diagnostic screen. On it uncheck the box 
that displays the diagnostic screen each time you 
boot. 

You can also turn off Windows services that you 
don’t need, but you shouldn’t do this unless you are 
very knowledgeable. However, it doesn’t hurt to look 
at what’s running, and you may learn something. 
Open the Services window by clicking Start → Con-
trol Panel → Administrative Tools → Services and 
the System Configuration window by clicking Start, 
then Run, typing “msconfig” and selecting the ser-
vices tab. Move the windows so you can see both. 
Clicking on a name in the services window will dis-
play a short description. Removing a check mark in 
the System Configuration window will disable that 
service, but no matter how confident you are, don’t 
disable any service marked “essential”. 

Check for unsigned files and drivers; these can be 
corrupted files or programs not approved by Micro-
soft. Click Start → All Programs → Accessories → 

System Tools → System Information → Tools 
→ File Signature Verification Utility → Start. 
The search will take several minutes; then a 
list will appear showing all the program files 
without valid signatures. Consider deleting 
these (by using the Add/Remove Pro-
grams tool) . 

Another utility you should know about 
is System Information (Start → All 
Programs → Accessories → System 
Tools → System Information). This 

doesn’t allow you to change 
anything, but you can learn a 

lot about Windows by ex-
ploring it. For instance, if 
you click on the plus box by 

Software Environment 
then on Startup Pro-

grams, it will 
show you a list 

(after a pause) 
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ger, nationally recognized computer expert and au-
thor at CompuKiss.com - Read the complete review 
at http://www.compukiss.com/visioncenterhtm/
review380.htm 

LapWorks 

http://lapworks.net 
20% off all products – just enter APCUG20%OFF 
in the Promo Code Calculator.  The discount is 
valid through June 30, 2006. LapWorks features 
Laptop legs to cool and elevate your notebook com-
puter; laptop desks that are scientifically proven to 
significantly reduce heat build-up in your notebook 
computer; the SwivlPad is an ultra thin turntable or 
lazy susan that allows you to easily swivel your 
notebook computer to show the display to another 
person—it also works with LCD monitors, or simi-
lar size objects. 

TrendMicro 

www.trendmicro.com/offers/usergroup 

PC-cillin Internet Security - $29.95 

Corel — 50% off 

http://www.corel.com/promotions/cug_usd.html 
WordPerfect Office X3: $159 
CorelDRAW Graphics Suite X3: $179 
Corel Painter: $229 
Paint Shop Pro X: $59 
Corel Photo Album 6: $29 
Corel Painter Essentials 3: $99 
Prices are US Dollars 

APCUG does not endorse these products, the 
offers are sent to you for information only. 

Red Mercury 

http://www.red-mercury.com/ 
The discount is $5 off instantly for any of the Acid-
Solitaire collection games. If you buy more than one 
of the games in the collection, you get an additional 
$10 off each additional game. The discount ends up 
being $14.95 for the first game and $9.95 for addi-
tional games. 

WebEyes 

http://webeyes.us/ 
$24.95 / with discount $19.95 – APCUG is the pro-
motion code 

The Internet Explorer software that allows you to 
adjust type size easily (144 pt) and eliminates scroll-
ing. By clicking on “Read like a book” you can sim-
ply turn the pages like a book. 

“If you need a little help reading Web pages, you will 
gladly pull out your wallet for this one! “ Sandy Ber-

APCUG Deals 
Judy Taylour, Chair, APCUG Benefits & Services Committee 

Washington Area Computer 
User Group (WAC)Meetings 
WACUG Meetings will be held on No-
vember 18, 2006,  from 12:30 to 3:30 pm . 
at the Fairfax County Government Center, 
12000 Government Center Parkway, Fair-

fax, VA [Topic: Internet Security, Debunking 
Internet Myths]  

You do not need to be a member to attend.  For 
more information on WAC meetings and events, 
call the WAC AnswerLine (voice) at  
(703) 370-7649. Also see WAC’s Web Site at 

http://www.wacug.org/ 
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the least. Just don’t write me if you’re a farmer trans-
porting a pregnant cow in a Cessna. ;-) 

And so, some basic security info is at hand. At least, 
enough to get you down the road to securely surf the 
Web with confidence. 

Here’s a list of things you should do before plugging 
into the Net: 

1. Be sure you have both a firewall and anti-virus pro-
tection. Without either, it could be literally only 10 or 
15 minutes before your system is compromised.  Typi-
cally, free products give you bare bones applications, 
which is fine if you’re not going to do any heavy surf-
ing. Going to be online 3, 4, 5 hours a day? Make the 
investment and get a few extra perks. 

2. Now that you have a firewall and anti-virus in-
stalled, you can go online. Make sure the operating 
system that came installed by the reseller has all criti-
cal patches from Microsoft installed. This single event, 
should it be skipped could be the most damaging. You 
see, malware writers know all the exploits and vulner-
abilities in the OS, and write accordingly to take ad-
vantage of them to deliver their bundles of joy. 

3. Find a dependable source for anti-spyware. Many of 
the most respected applications on this category are 
free, with some very nice paid versions as well.  

Now doing those three simple basic things will get you 
started. You still need to read up about tweaking Inter-
net Explorer, to help tighten its out of the box security 
(kind of like adding extra stuff to a new car). Then de-
ciding what kind of security settings or software to use 
for email. 

Hopefully you’re not overwhelmed just yet. My pur-
pose is to inform on a basic level for the new user. 
Once you’re up and running, other subjects delving 
deeper into technical issues can be addressed. 

There is no restriction against any non-profit group using this article 
as long as it is kept in context with proper credit given the author.  
The Editorial Committee of the Association of Personal Computer 
User Groups (APCUG), an international organization of which this 
group is a member, brings this article to you. 

You’ve just come home with your new computer. 
How delightful! Now you’re ready to surf the web 
and download some music—legally of course—and 
send out a few emails to family and friends.  

As you’re about to plug in the networking cable you 
remember something the sales associate mentioned. 

“Be sure and get some anti-spyware and security 
stuff”.  

“Bah,” you figure. The guy is just trying to sell you 
more that you don’t want or need, right? 

Onward you go, dismissing the comment and salivat-
ing as Google pulls up page after page of amazing 
information about things you never knew existed. 
Need to know about livestock birthing? No problem! 
Have a hankering for finding just the right flap set-
tings for your Cessna? Piece of cake! 

But wait, what’s with these ‘extra’ windows that 
keep popping up and obscuring your view? And why 
is it that your homepage is now set at 
www.somePornSite.com? 

“Hmmmm,” you wonder, thinking back to what the 
sales associate said... 

Welcome to the Net! You have just been hijacked 
and had your first “drive-by” install. No—not the 
type of drive-by from the gang downtown, guns a’ 
blazing, tires screeching—it appears to have come 
from that “friendly” website who just happened to be 
pushing some ‘extra’ software onto unsuspecting 
users such as yourself. 

The scenario above is an all too common occur-
rence—though, more than likely, excluding both of 
those searches via Google. And if you did actually 
perform those searches, you are indeed unique to say 

Anti-Spyware Basics 
By Dave Gerber, Dave’s Bits & Bytes, A Periodic Newsletter for the Members of the Sarasota 
PC User Group and the World!!   
Director, Sarasota PCUG, Florida www.spcug.org   http://davebytes.com/ 

NCTCUG Ed. note: Be sure to check out 
the club website page on security:  
http://www.nctcug.org/protection.html 
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WebRing.com combines aspects of a portal site 
(linking to WebRing-related information and re-
sources), a directory site (providing categories of rings 
such as Business & Finance, Family & Home, Health 
& Wellness, and Hobbies & Crafts), and a search tool. 
Searching is helpful when you’re not sure which cate-
gory includes your topic of interest or when the topic 
may span categories. For example, searching on 
“gardening” located 128 WebRings. That doesn’t 
sound like many, but remember that each ring includes 
a few, dozens, hundreds, or thousands of individual 
sites. Among the first 20 rings, Friends of the Garden 
http://e.webring.com/hub?ring=friendsgarden has the 
most members, 243 Web sites. Its cheery greeting 
reads “Welcome to Friends of the Garden Web Ring. 
We are the largest gardening Web ring in the WebRing 
Community! Please visit our members and if you have 
a gardening web page, consider joining! We welcome 
both the backyard gardener with his own home page or 
the commercial grower. All have something interesting 
to add to our virtual garden tour”. 

Navigating WebRing.com by topics provides a hierar-
chical view of its thousands of WebRings—for exam-
ple, clicking the Science category yields about two 
dozen disciplines including Astronomy, Biology, Ecol-
ogy, Energy, etc. Biology includes an amazing 3200 
rings, while the new science of Nanotechnology has 
only one ring. 

Ring hubs offer a unique search tool with two pull-
down menu choices. You can enter a keyword and 
search only the ring whose hub you’re viewing (the 
Ring choice), or search the entire WebRing.com list of 
rings (the WebRing search choice). Searching within 
the ring can help narrow search results. For example, 
the Amateur and Pro Photography ring has 87 sites. If 
I’m interested in English photography, rather than 
touring the entire ring—entertaining though that might 

(Continued from page 1) be—I can use the ring search for “England” and find 
the four relevant sites. 

Clicking the Random link is like closing your eyes 
and hopping to an unknown site—it can be entertain-
ing or not, depending on luck. Previous/Next links 
navigate around a ring’s sites so you’ll eventually re-
turn to your starting point. And Join Now is for Web-
masters to enroll sites within a ring; this requires first 
creating a free account on WebRing.com. 

WebRings don’t replace search engines, directories, 
portals, one’s own bookmarks, and referrals from 
friends for finding worthwhile material. And they 
only link sites that have chosen to enroll. But they’re 
a useful and powerful tool for locating and navigating 
congenial and related Web sites, and they give topics 
such as gardening and photography much more a 
sense of community than do bare links from a search 
engine.  

This article originated on AARP’s Computers and Technology Web 
site, http://www.aarp.org/computers, and is copyrighted by AARP. 
All rights are reserved; it may be reproduced, downloaded, dissemi-
nated, or transferred, for single use, or by nonprofit organizations 
for educational purposes, with attribution to AARP. It should be 
unchanged and this paragraph included. Please e-mail Gabe Gold-
berg at gabe@gabegold.com when you use it, or for permission to 
excerpt or condense. 
There is no restriction against any non-profit group using this article 
as long as it is kept in context with proper credit given the author.  
The Editorial Committee of the Association of Personal Computer 
User Groups (APCUG), an international organization of which this 
group is a member, brings this article to you. 
 
August 2006 note from APCUG: We won’t be receiving any more 
articles from Gabe Goldberg since his assignment for writing arti-
cles for the AARP Computers and Technology section of http://
www.aarp.com has ended. You might want to send them an e-mail 
letting them know how important you think it is that AARP continue 
to feature computer how-to articles, reviews, etc.  
http://www.aarp.org/about_aarp/contact/    
You can still read some of his articles online at:  
http://www.aarp.org/learntech/computers/  
 
NCTCUG Ed. note: We will continue to print Gabe’s articles that 
we had already received! 

Club Election Notice 
Elected at the October 4, 2006 Annual Meeting: 
President    James Rhodes   
1st VP   Ron Schmidt  2nd VP Roger Fujii  
Treasurer    Paul Howard  
Secretary    Roger Arnold  
At-large directors: 
Bill Walsh   Mel Mikosinski 
John Keys   Nick Wenri 

Washington Area User Group Partners 
Working Together For Our Members 

NCTCUG.ORG  WACUG.ORG  
CPCUG.ORG 

For more information see: 
 http://www.nctcug.org/waugp.html 
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NCTCUG Information 

Officers and Directors 
All officer terms expire 2007 
President   Jim Rhodes 703-931-7854 
1st VP Ron Schmidt 301-577-7899 
2nd VP Roger Fujii 703-426-5917 
Treasurer Paul Howard 703-860-9246 
Secretary Roger Arnold 301-946-7770 

Director: term expires        
Bill Walsh 2008 703-241-8141 
Mel Mikosinski 2008 
John Keys 2008 703-451-0896  
Nick Wenri 2008 703-759-3938 
Fred Cook 2007 703-815-1423 
JJ Davies 2007 703-379-9222 
Sy Fishbein 2007 703-536-5894 
Dean Mires 2007 301-931-2400 

Article Submissions 
Articles, helpful hints, and other items of interest to readers of the NCTCUG Journal are 
always welcome and will be published as soon as possible after submission. Priority is given to 
members’ contributions. Items may be submitted via modem to the BBS or on diskette. 
Submissions to the BBS should be uploaded to the Newsletter Conference and a message left 
for the Editor. Files should be straight ASCII, unformatted, with C/R only at end of 
paragraphs; no indents for paragraphs should be used. Preferred format for diskettes is MS-
DOS 3½ 720k or 1.44Mb. Diskettes in other formats may be submitted but there will be a 
considerable delay in processing. If absolutely necessary, items may be submitted in hardcopy 
only but these will also meet with delay. 

Membership Policy 
The National Capital Tandy Computer Users Group, Inc. is a non-profit [501(c)(3)]
organization founded in 1978 to educate users of all Tandy computers and MS-DOS 
compatible computers. Membership dues are $25.00 (U.S.Funds) per year, with a $5 surcharge 
for international mail. Membership in NCTCUG includes membership in all SIGs, access to 
the BBS and software libraries, and subscription to the Journal published 8 times per year. 
Applications may be obtained at any club meeting, by downloading from the BBS, by calling 
one of the officers or board members, or by writing to the club. A sample newsletter, 
membership application and related information may be obtained by enclosing $1 and mailing 
your request to Jim Rhodes, 201 S. Kensington Street, Arlington VA 22204. 

.Advertisement Policy 
Members' advertisements: Ads are accepted from members for non-commercial purposes at no 
charge. Copy should be sent to the Editor in the same format as article submissions. 
Commercial Advertisements: Ads are accepted from commercial advertisers at the rate of $60 
per full page, per appearance, with discounts for multiple insertions. Smaller ads are priced 
accordingly. Payment for ads must be made in advance of appearance. Advertisers must supply 
a permanent address and telephone number to the editor. 

Reprint Policy 
Permission to reprint articles from the NCTCUG Journal is given to school, personal computer 
club, and nonprofit organization publications, provided that: (a) NCTCUG Inc. receives a copy 
of the publication; (b) credit is given to the NCTCUG Journal as the source; (c) the original 
author is given full credit; and (d) the article author has not expressly copyrighted the article. 
Recognition is one means of compensating our valued contributors 

Newsletter Staff  
Editor 
Blair Jones 202-362-7344 
bjones44@bellatlantic.net 
Exchange Newsletter Editor 
Ron Schmidt 301-577-7899 
 
COMPUCENTER BBS 
Is no longer in operation. It has 
been replaced by the 
‘compucenter’ mailing list at 
http://groups.yahoo.com/ 

http://groups.yahoo.com/group/
compucenter/ 

If you are moving 
Please send your change of 
address to the club PO 
box as soon as possible to 
avoid missing issues. 

Thank You! 

NCTCUG, Post Office Box 949, Arlington VA  22216 

 Club Information call: 301-577-7899 Web Site: www.nctcug.org 

17. TrackEngine www.trackengine.com  

Notifies you via email of changes in Web pages that 
you select. You can preview the changes or view the 
whole page via email, with changes highlighted. 
Choose the Web address of a neighborhood theater, 
to see what plays are coming up. Or see every new 
installment of a favorite newspaper column, without 
having to buy the paper.  

18. GovBenefits.gov  http://govbenefits.gov  

A source of information on over 400 government-
funded programs that extend benefits for which you 
may qualify, including compensated volunteering. 
Features a confidential questionnaire designed to 
point you to the most likely matches.  

(Continued on page 16) 

The Web is a marvelous resource, and most of us 
come nowhere near tapping its full potential. I’ve 
attempted here to list 29 websites that without any 
necessary downloading provide exceedingly useful 
free non-specialized services and tools, that require 
no particular knowledge except how to navigate the 
World Wide Web.  

16. Anybirthday http://anybirthday.com  

A fun site that can divulge your friend’s birthday or 
even tell you where to mail the card.  

29 Useful Bookmarks — Part 4 
By Richard Johnson, TUGNET www.tugnet.org 

Richard Johnson is a writer and editor, and founder/administrator of 
FREE FOR ALL The Skills Pool, a 29-year-old membership organi-
zation (http://theskillspool.org). He is a volunteer with TUGNET Help-
Contact for assistance with Internet Explorer, Outlook Express, and 
Gmail. You may reach him at rj@theskillspool.org. 
There is no restriction against any non-profit group using this article 
as long as it is kept in context with proper credit given the author.  
The Editorial Committee of the Association of Personal Computer 
User Groups (APCUG), an international organization of which this 
group is a member, brings this article to you. 



NCTCUG, Inc. 
P.O. Box 949 
Arlington VA 22216 

19. AddALL  www.addall.com  

Use this site to find the very best price for a book you 
want to buy. Unlike most other comparison sites, it fig-
ures in shipping costs for your location. Links will take 
you to pages for magazine subs, music CDs, and videos. 

20. jux2  www.jux2.com  

Jux2 lets you receive and compare search results from 
two or three different search engines, or see what you’re 
missing from your regular search results. (According to 
the site, competing search engines typically share fewer 
than 4 out their 10 top results.) Still in development, it’s 
currently limited to Google, Yahoo, and Ask Jeeves.  

21. Medem Medical Library  
 www.medem.com/medlb/medlib_entry.cfm  

Searchable and browsable medical library, organizing 
contributions from 45 medical societies. Features a com-
plexity indicator for each article, from “introductory” to 
“professional.”  

22. Metacritic  www.metacritic.com/film 

23. Kids-in-mind  www.kids-in-mind.com Metacritic is 
an excellent source for movie critiques. For each film, it 
arranges its large variety of reviews from most to least 
favorable, and then tabulates the opinions, for an over-
all “metascore.” (Additional Metacritic pages cover 
videos, music, and games.) For evaluating movies for 
children, or if you have a concern about violence, sex, 
or profanity, Kids-in-mind will rate and describe each 
film’s content in those three areas.  

(Continued from page 15) 

November 2006 
1st Wed. (11/1)   
7 p.m. General Meeting 

4th Wed (11/22)   
7 p.m. Internet SIG 

3rd Monday (11/20)   
7 p.m.  Board of Directors  
 

All meetings are at Carlin Hall, 5711 S. 4th St., 
Arlington VA: East off of Carlin Springs Rd, just 
south of Arlington Blvd/Route 50. 
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